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Before you start

The NEXTSTEP
workspace is where
you get things done,
imagine doing things
you’ve never done
before, and do things
beyond imagination—

all with a few keystrokes,

some mouse clicks, and
lots of windows.

You can get a quick introduction to
NEXTSTEP" by reading this book while
sitting in front of your computer, trying things
out as you go. But there are a few things you
need to do before you start:

» Set up your computer and make sure

NEXTSTERP is installed on it.

Your computer’s owner’s guide shows you
how to set it up.

Installing and Configuring NEXTSTEP shows
you how to install NEXTSTEP.

Upgrading shows you how to upgrade from
an earlier release of NEXTSTEP.

» Get a user name and password from your

system administrator.

If your computer is on a network, your
system administrator will assign you a
user name and password so you can log
into your computer.
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Basics

Turning on
the computer

You turn on some computers with a single
keystroke. Others have separate power
switches for the computer, display, and
peripherals. '

1 If your display and other peripherals have
power switches, turn them on.

2 Press the power switch on your computer.

Caution: Don’t turn on the computer if
there’s a disk in the floppy disk drive, or
NEXTSTEP won’t start up.

3 Ifyou’re asked to pick an operating system,
type n and press the Return key to start up
NEXTSTEP.

To find out where the power
switch for your computer is
located, see its owner’s guide.



Logging in

Tip: The Return, Tab,
and Backspace keys
may be labeled on your
keyboard with different
names than those used
inthis book. Ifyou‘re not
sure which key is which,
see the NEXTSTEP
User’s Guide and the
owner’s guide for your
computer.

When NEXTSTEP finishes starting up, the
login window opens on your screen (a window
is a rectangular area containing information).
You must Jog 7 to use the computer, unless
you or your system administrator have set
things up differently. The login process
prevents unauthorized people from using
your computer.

To log in you need a user name and password,
which you get from your system administrator.

1 "Type your user name in the Name field.

The blinking vertical bar in the Name field
marks the zusertion point, where text you
type is entered.

If you make a mistake, press the Backspace
key to back up over each character you want

to retype.

2 Press the Tab key to move the insertion
point to the Password field.

3 ’'Iype your password. Use the Backspace
key to correct typing errors.

Although the insertion point follows your
typing, your password isn’t shown.

4 Press Return.

If you typed your user name and piassword
correctly, the login window closes and you
enter the workspace.

If you made mistakes while typing, the
window shakes back and forth, indicating
that your login attempt has failed. If this
happens, go back to step 1 and try logging
in again.

i Na'r‘neu[ star| I
Insertion point i — : ST
~ Password[_
Your password doesn’t L il
appear as you type.




Entering the
worlkspace

After you turn on the computer and log in, you
enter the workspace, which is where you work
in NEXTSTEP.

Your workspace may not exactly match the
one shown below, but it will have many of
the same features.

Icons are small pictorial representations of
things you work with in the workspace.

The application dock (or dock, for short) is
the column of icons along the right edge of

“the workspace. All but one of the icons in the

dock represent applications. (The exception is
the recycler icon—usually at the bottom of
the dock—which is described in “Organizing,”
later in this book.)

The icon at the top of the dock represents the
Workspace Manager™ application.

The main Workspace Manager window is
called the File Viewer. It gives you access to
your files.

The Workspace menu contains commands, such
as Edit and Log Out, that you can choose to
make the Workspace Manager do something.

The cursoris the small black arrow that moves
when you move the mouse. You move
the cursor to point to things on the screen.

A menu lists
commands you
choose to make
an application do
something.

Windows

Services

The cursoristhe s

smallblackarrow ;04
that moves when w=
you move the

NaxtApps -
o i

mouse.

Aniconisasmall

pictorial

representation
of something,
like a file or
application.

The File Viewer
provides access
to your files.

This column of
icons is the

application dock,
or dock, for short.




Using the
mouse

Tip: Initially, you can
use either the left or
right mouse button—
they each have the
same effect.

Except for typing text, you can do all your work
with the mouse (or whatever pointing device
you have). You just need to know a few basics.

» Slide the mouse on a smooth surface.

As you slide the mouse, the cursor moves on
the screen.

» Point to an object on the screen by moving
the mouse so the cursor is on top of the
object.

» Click by pointing to an object and, without
moving the mouse, pressing and
immediately releasing a mouse button.

B Press by pointing to an object and, without
moving the mouse, pressing and holding
down a mouse button.

Press a black arrow button .¥] (if there is
one) in the File Viewer window. As long
as you press, the button is highlighted;
information may also move in the window.

Drag this title Dar. e———

Click this iCON. w——— St MextApps

2 G rernote dis

» Drag by pointing to an object, pressing
and holding down a mouse button,
moving the cursor to a new location (by
sliding the mouse), and then releasing the
mouse button.

Drag the sitle bar at the top of the File
Viewer window. The window moves in
the workspace.

"The cursor changes shape as you work. The
most common forms are:

R an arrow for pointing to objects
¥ anI-beam for editing text

92 aquestion mark for getting help

¥y arotating disk indicating that the
application is busy and you must wait
(or switch to another application)

Press this button.




Choosing
commands

Tip: On most keyboards,
the Command key is
the key to the left of the
space bar.

One way you tell an application what to do is
by choosing a command from a menu. Each
application has a main menu that appears in
the upper left of the workspace while you're
working in the application.

» To choose a command, click it in the menu.

The command is highlighted and
carried out.

A command with an arrow [ opens another
menu, called a submenu, which contains
more commands.

"The submenu stays open until you choose a
command from another menu, such as the main
menu. (You can also close a submenu by simply
choosing the command that opened it.)

| VWorkspace I File

info” ) Open 0
File N | openas Falder @
Edit - NewFolder  n
Disk i Duplicate - d
view ) Compress
Toals | Destroy r
‘Windows -} Empty Recycler -
Services. . I

Hide 7

Logout ™ g

If a command has a character
next to it, you can choose that
command from the keyboard by
holding down the Command key

» To keep a submenu open, detach it by
dragging its title bar.

Workspace

nfo r~ Open ... > 0
Filew oo Open as Foldar O
Edit ‘NewFolder -~ .n
Disk Duplicate —'d
- View o Compress

‘Tools 1| |Destroy T
Mindaws 1 ‘Empty Recycler
Services - i

-Hide h

LogQut g

» To close a detached submenu, click the
close button [¥¢] that appears in the right of
its title bar when it’s detached.
]

Open 0
Open as Folder” O
—

-

| New Folder
Duplicate =~
| Compress
Destroy” "y
‘Empty Recycier

A dimmed command (shown in gray rather
than black) is currently unavailable—usually
because it’s not relevant to what you’re doing
at the moment.

Finder..  ,f

while typing that character.

When you choose a command
that's followed by an ellipsis (...),
a panel asks for additional

information about how to carry
out the command.



Logging out

ﬂp:A@ symbol on a
button indicates that
pressing the Return key
has the same effect as
clicking the button.

When you’re done working with NEXTSTEP,

log out to quit all applications that are running.

Before logging out, make sure you save any
work you’ve done in an application, or your
work will be lost. (Saving is described in

“Files,” later in this book.)

1 Choose the Log Out command from the
Workspace menu. (If the Workspace
menu isn’t visible, click in the File Viewer
window or double-click the NeX'T™ icon
at the top of the dock to make the
Workspace menu appear.)

Choose Log Out from the
Workspace menu.

I Vorkspace

The Log Out pane/ opens (a panel is a kind
of window, often used to ask you simple
questions).

If you change your mind about logging out
(orif you choose Loog Out by accident), click
the Cancel button in the Log Out panel.

Click the Log Out button in the panel.

If an application contains unsaved work, a
panel may open, giving you a chance to save
your work.

Logging out returns you to the login window.

Then click the Log Out button in the panel.

 Hide

R o

Log Out




Basics

Turning off If you don’t expect to use your computer for a 3 When a message says it’s OK to turn off the
the computer day or two, you should turn it off. computer’s power, press the power switch

. on the computer.
As when logging out, make sure you save any

work you’ve done in an application before Caution: Don’t turn off the power to the
turning off the computer. computer before a message says it’s OK, or

1 Choose the Log Out command from the else you might damage your startup disk.

Workspace menu. 4 Ifyour display and peripherals have power
The Log Out panel opens switches, turn them off, too.
2 Click Power Off in the panel. When the login window is showing, you

can turn off the computer or restart it by

If an application contains unsaved work, a A clicking one of these

panel may ask if you want to save your work ,\.:\fi ‘ buttons in the login window.
before the application quits and you turn off ~ _festart | | Powe ‘
the computer.

Some computers turn themselves off
automatically when you click the Power Off
button. Otherwise, a message asks you to
wait until it’s safe to turn off the computer.

Choose Log Out from the Then click the Power Off button in the panel.
Workspace menu.

Workspace

Power Off

LogOut Kk g




i

S

e,
) LR \_M/,,T S R

JUURS S SN SO N R




Applications

Starting up Your computer comes with several applications,
an application such as Edit and NeX T'mail™. You can keep

icons for these and other applications in the
application dock. :

Notice that before you start up an application,
its icon in the dock has an ellipsis [¥
lower left corner. After you start up the
application, the ellipsis goes away, indicating
» Lo start up an application from the dock, that the application is running.
double-click its icon. (To double-click, click
twice in quick succession).

The icon is highlighted while the

application starts up, and Not running  Running

then the application’s main o

menu appears. One or You can also start up applications by double-
more windows may also open. clicking their icons in the File Viewer or by

opening files from the Workspace Manager
(see “Files”).

You can start up
an application by w=""-—

double-clicking Mevsags

its icon in the :;Tm - Active.mhox

o oM 8| QT
Windows T X . A 3 1 )
Print.., ¥} i Deite - Maoxes Fing )

When you first =/ P e
start up an L e
aPPIication, the s ‘Jur}él ”Myaxeaw Fa Radospots
Workspace menu 2 (SRS SRRt e

goes away and
the application’s
main menu
appears in its
place.

The application
may also open
one or more
windows.




Running
multiple
applications

You can run several applications at once—
for example, so you can look up information
in Digital Librarian™ while reading your
Mail messages.

To run multiple applications

» Start up each application you want to run.

Each time you start
up an application,

its main menu
appears in place of
any menus that were previously visible.
Typically, one or more other windows open,
often covering windows that are already
open (see “Windows”).

Although several applications might be
running, you work in only one at a time—
the active application. The active application
is the one whose menu is showing,

When several applications are running, you
can switch to the one you want to work in.

To switch applications

» Click in a window that belongs to the
application you want. Or
double-click the application’s
icon.

When you switch applications,
the menus switch. If you click in a window,
that window comes to the front.

When an ‘

application starts g’:’mhe" o RERE =1 UNTITLEDAT — ~

up, it becomes Tagel T ]

the active ?;Z : ) Librarianbshif — ~/Ubrary/Bookshetves
application Fomal 1

and its main e ;

menu replaces Services_I*

the previous e N L -

application’s SRS ;ﬁm LL]II
menu. List Titey Search InContents | word -}

You can click in
an application’s

window to

switch to that
application.

1



Applications

Hiding an If you’re done working in an application for
application now but may use it later, you can hide the
application to get its windows out of the way.

» Choose Hide from the application’s
v ... INAIN menu.

ek o] All its windows disappear, but
“—2 the application is still running
and you don’t lose any unsaved work. If
other applications have windows open,
one of those applications becomes active.

By hiding applications, you can have several
applications running and easily accessible.
However, your workspace remains free of
windows you’re not using at the moment.

When you’re completely done using an
application, quit the application—as described
on the page after next.

Format ¢ |
[ Windows +-
Print. - p
Services I
Hide h
Gt g

When a
docked
application is
hidden (as
opposed to
not running),
there's no
ellipsis{¥
in its icon.

Tip: If you hold down the
Command key while
double-clicking an
application’s icon in the
dock, that application
becomes active and all
other running
applications are hidden.

12




Unhiding an When you want to work again in a hidden If you hide the Workspace Manager, you
application application, you can unhide it. e can unhide it by double-clicking
the NeXT icon at the top of the
application dock.

P Double-click the application’s icon. /

Its windows appear again—
just as though the application
hadn’t been hidden—and
the application becomes the
active application.

Info r o UNTITLED.Af — ~
Bookshelf r i

Taget T

“Ubrarlanbshif — ~/Library/Bookshelves 1

g b

Windows 1
Print.  p
| Services T
| Hide h o - c L.

= Double-click an
application’s
icon to unhide it.

This Uphtt

" fion Reparts

Tip: Whenever you want
towork in an application
(whether or not it's
hidden), you can get

to it by double-clicking
its icon.

13



Applicatiohs

Quitting an

application application, quit the application.

» Choose Quit from the application’s

- ~__. Imain menu.

Services I
Hide -: .. h
Quit kg

When you’re completely done working in an

If you haven’t saved your work in
the application, a panel gives you

a chance to save before quitting. Then the

application’s windows close.

If you don’t save your work when you quit, it is
lost (see “Files”). :

When you log out, all running applications quit
automatically.

nfo "
{ Mailbox .- 7
Message 1
Conmpose
Edt v}
Fomat
Windowis

Active.mbox

Print - p
Services © A 1 Oct21 Steve Jobs
Hige * K 1 A .. 2 Junet Plemrs Poupon
A 3 June'r KayaGrey
4 June 1 Anne Winr
rg

June 1 Max Bas!

Welcome 10 the NeX
. Festival program™

Brght CO cover.

Cencert Tanightt

““Radio spots

L

T World

When you quit
an application,
the ellipsis

in its icon,
indicating that
the application
is no longer
running.

Tip: Hide rather than quit
applications you plan to
use later—it takes less
time to unhide an
application than it does
to start it up again.

14







Windows

Organizing

windows

16

NEXTSTEP presents information in
windows. Several windows may be open in
your workspace at the same time.

Some windows, such as one containing an Edit
document, provide a place to work. Others,
such as panels, give you options for controlling
an application. Or they may simply provide
information.

"To organize your workspace, you can change
the size and shape of windows or make them
disappear completely, as illustrated with the
Edit window below.

Click the miniaturize button to PUT me=l?
a window aside
temporarily, changing

it into a miniwindow )
that appears at the f& Bl
bottom of the screen. :

To get the window back as it was,
double-click its miniwindow.

[ San Francisco
May 1, 1994

Drag the title bar to move a

Emily Bright.rifd

FOR IMMEDIATE RELEASE

Click the close
buttontoclose
a window that
you’re done
using. The
window
disappears
completely.

PO Box 334578
Son Froncisco, CA 94105

e Planet Productions

Contact: Jason Starr
Phone: 415-111-2222
Email: jstarr@blues .com

window (don’t drag a button).

Emily Bright releases first album:

Git on down the road

Emily Bright’s first album s a bright spot on a stormy horizon. The.
eighteen-year-old singer from the streets of Chicago combines the aching
e sound of old-time blues with a searing message from her generation. But
; her voice—full of energy and open-throated passion—doesn’t let you
wallow in despair. Itmakes you want to make a difference.

Drag the resize bar to make the
window larger and to see more of
its contents, or smaller so it takes
up less space.

The title cutis a trib

about to become als

around outside the b
She got her messagg
message is not what
free meal or a dealer]
but for the planet. Al

e to old-time blues legend, Skip James, but Bright is
end in her own right. Bright leamed her craft hanging
ckdoors of bars and clubs on Chicago’s South Side.
from kids like herself, kids living on the streets. The
oumight expect. These kids are not justlooking for a
They’re looking for a future, not only for themselves
d Bright sings the message loud and clear.

T - PR

|
End region

Drag either end region left or
right to change the window's
width. height.

" 5
Middle region

Drag the middle region up or

down to change the window'’s

End region

Drag either end region
diagonally to change the width
and height at the same time.



Reordering Like sheets of paper loosely stacked together, The window comes forward and its title

windows windows can overlap or completely cover bar typically turns black, indicating that
each other. it’s the 4ey window. When you use the

keyboard, anything you type appears in

P 'To bring a window forward so you can work the key window,

in it, click in it.
Remember that clicking in a window also
makes that window’s application the active
application (if it isn’t already).

Take care not to click a button (such as a
window’s close button) when you click in
the window.

] Emily Brightrifd — /Het/publicity/Press Releases/s May le

Mﬁg Blue Planet Productions

FOR IMMEDIATE RELEASE

PO Boz 334573
Son francizen, CA 94105

" San Francisco Contact: Jason Starr
May 1, 1934 Phone: 415-111-2222
Emall: jstarr@blues.com

Emily Bright releases first album:
Git on down the road

Emily Bright’s first albwm is a bright spot on a stormy horizon, The
eighteen-year-old singer frem the streets of Chicago combines the aching

When vou want to work in a ; : ER Y K 5 i nessage from her generaton. But
i Y ant g 3 CD Cover.rifd’ —. /Net/Creative/grey sted passion—doesn’t et you

window—to type in it, for | rmske a difference.

example—click in the window to s

make it the key window. LN

legend, Skip James, but Bright is
tht. Brightleamed her crafthanging
d clubs on Chicago’s South Side.
elf; kids living on the streets. The
These kids are not justlocking for a
for a future, not only for themselves
message loud and clear.

EMILY BRIGHT

GIT O DOWN THE ROAD

The key window's title bar is black.

17



Windows

Scrolling

Tip: The scroll knob’s
size and position
indicate how much of
the total information
you're viewing and
where you are in the
document. Forexample,
if you're on page 2 of a
3-page document, the
vertical scroller fills the
middle third of the bar.

18

Vertical scrollers are for scrolling up and down,
while horizontal scrollers scroll left and right.

When a window contains more than it can
display at one time, you can s¢7o// to see more.
If a document window displays one page of a
25-page document, for example, you scroll to
see the other pages.

In some cases, you scroll using buttons
that aren’t in a scroller but that stand
alone. (A dimmed button means you can’t
The most common way to scroll is by using a scroll any further in that direction.)
scrofler—a gray bar with a knob and scroll

buttons.

Scroll buttons

Scrolllknob

Scroller

Click in the gray bar to scroll
quickly—the scroll knob jumps ~ — e-EEEE—
to the position under the cursor
as though you dragged it there.

Blue Plunet Productions

FOR IMMEDIATE RELEASE

Contact: Jason Starr
Phone: 415-111-2222
Email: jstarr@blues.com

San Francisco
May 1, 1994

Drag the scroll knob to scroll
continuously.

Emily Bright releases first album:
Git on down the road

Emily Bright's first album is a bright spot on a stormy horizon. The
eighteen-year-old singer from the streets of Chicago combines the aching
sound of old-time blues with a searing message from her generation. But
her voice—full of energy and open-throated passion—doesn’t let you
wallow in despair, Itmakes you want to make a difference.

The title cut is a tribute to old-time blues legend, Skip James, but Bright is
aboutto become alegend in her ownright. Brightleamed her craft hanging
around outside the backdoors of bars and clubs on Chicagoe’s South Side.
She got her message from kids like herself, kids living on the streets. The
message is not what you might expect. These kids are not just looking for a
free meal or a dealer. They're looking for a future, not only for themselves
but for the planet. And Bright sings the message loud and clear.

Click a scroll button to scroll by a
line or other increment in the
direction the button points.
Press a button to scroll
continuously by increments.

Emily Bright may have her roots in a blues past, but she’s got her eyes
on the future. Her sound is soulful, down-and-dirty, and innocent at the
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Files

The File Viewer

Tip: If you see words
instead of icons in your
File Viewer's current
view, choose Icon from
the Workspace
Manager's View menu,
so what you see in your
File Viewer more closely
matches the pictures in
this book.

20

NEXTSTEP organizes information in fi/es
and folders. A file might contain a memo, a
drawing done in a graphics application, or the
application itself. Folders contain files and
other folders.

"The files and folders in your computer are
organized in a hierarchy, where the root folder
branches into other folders, which can
contain files and more folders, to as many
levels as you want.

"To get to files and folders, you use the File
Viewer—a Workspace Manager window that
appears when you enter the workspace. Files
and folders appear as icons in the File Viewer.

At the top of the File Viewer is the s/elf, where

you can put icons of files or folders you use
often and want to keep handy.

In the middle of the File Viewer is the icon path.

It shows you where you are in the file system.

"The highlighted icon at the right is the current
file or folder. The icons to the left of the current

folder trace the path back up the hierarchy to

Shelf

the root folder, which is represented by a
computer icon.

At the bottom of the File Viewer, the current
view displays the files and folders in the current
folder.

When you log in, your home folder is the
current folder, and its contents are displayed
in the current view. Your home folder
has the same name as your user name.

Icon path

Current folder

Current view

The current view
displays the files and
folders contained in
the current folder.




Finding files
and folders

Tip: You can use

the Clean Up Icons
command in the View
menu to straighten
up the current view
of icons.

You find files by opening folders.
» 'To open a folder, double-click its icon.

» To move back up the hierarchy, click a
folder icon in the icon path.

» "To open a folder on the shelf, click its
icon there.

When you open a folder, its branch of the
hierarchy appears in the icon path with the
folder’s icon selected. The folder’s contents are
displayed in the current view at the bottom of
the window.

Click a folder icon on
the Shelf Or in the eesse——

Many folders have an icon like this. But others

have icons that indicate something
special about the folder’s contents
or location.

"This icon marks your home folder,
which contains your personal files.

This icon marks someone else’s
home folder.

"This icon marks a folder that’s a
floppy disk you’ve inserted in a drive.

"This icon marks the INet folder, which
contains folders on other computers
on the network (if you’re connected
to one).

It doesn’t matter where a folder is or what
icon it has. You typically work in all folders
the same way.

icon path to display
the folder’s contents.

Bayside Tavern.if

Or double-
click a folder

» Greal American.nf

JJs MountainView,

icon here
to open it.

21



Files

Stocking The shelf is a convenient place to put icons of
the shelf files and folders you use often.

To put a file or folder’s icon on the shelf

1 Select a file or folder by clicking it in the
icon path or in the current view.

Its icon is highlighted.

2 Drag the highlighted icon into an empty
space on the shelf and release the mouse
button when a ghost image of the icon
appears.

Add an icon to the shelf
by dragging it from the
icon path or from the
current view.

To remove an icon from the shelf

» Drag the icon off the shelf—out of the File
Viewer window and into the workspace.

The icon is removed from the shelf, buz the
Jile or folder is not deleted—you can still find it
in the icon path or in the current view at the
bottom of the window.

Your home folder’s icon is always in the upper
left corner of the shelf—you can’t remove it.

“repettoire
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Customizing To add an application’s icon to the dock To remove an application’s icon from the dock

the application 1 Use the File Viewer to find the application » If the application isn’t running, just drag its

dock whose icon you want to add to the dock. icon out of the dock—into the workspace.
Many applications are in the NextApps » If the application is running, hold down the
folder, which is in the root folder. If Command key and drag it out of the dock.

necessary, click the root folder icon (it
looks like a computer) in the icon path and
when its contents appear in the current ,
view, double-click the NextApps folder to "To use the application again, you can find it in
open it. . the File Viewer.

You also have to hold down the Command
key to drag the recycler from the dock.

2 Select the application by clicking it in the
File Viewer.

"The application’s icon is highlighted in the
icon path.

3 Drag the highlighted icon into an empty
space in the application dock and release
the icon when a ghost image of it appears
in the dock.

Drag an
application icon
from the File
Viewer into an
empty space in
the dock and
release the icon
when a ghost

" FleViewer

from the dock.

image of it
appears. Netpps
wa
B t
You can’tremove e e
the NeXT icon —
it}

Llbranan.app

Preferences app Preview.app Pnnu;i;ﬁagevavp :
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Files

Opening a file

from the
File Viewer

24

You can open files you see in the File Viewer.
1 Find the file by opening the folder it’s in.
2 Double-click the file’s icon.

You can double-click a file’s icon in the
current view, in the icon path, or on the

shelf.

If the file is an application, the application

You can tell what application a file will open
in by the file’s icon, which resembles the
application’s icon. For example, if you double-
click an Edit file icon, Edit opens a window
that displays the file’s contents.

Edit application icon Edit document icon

starts up. Otherwise, the application

associated with the file starts up (if it isn’t
already running) and displays the file’s
contents in a window.

When you
open a file, its
contents are
displayed in a
window in the
application
associated
with it.

Double-click a

Info.

When an application that isn’t in the
application dock starts up, its icon appears

at the bottom of the screen. If you like, you
can drag the icon into the dock. Otherwise the
icon disappears from the bottom of the screen
when you quit the application.

File

Edit

Foral

“Utilities 1

Windows ¥ {-

Print. - pl-

Services r |

it

Hide
T

e

San Froniico, (A 4105

file’s icon to

open it. 2= Blue Planet Productions

In1990, jazz and blues legends at the Blue Planet Festival’s Paris debut
claimed the '90s as the decade of the Earth.

In 1991, recerd crowds swarmed the Berlin Wall in the largest peace and
music gathering in recorded history.

Now, in 1994, over 3 million people are expected to gather once again for
a five-day extravaganza in Washington, D.C. when...

Blue Planet Productions presents:

THE THIRD ANNUAL BLUE PLANET

“We are the Earth”

JAZZ & BLUES HERITAGE FESTIVAL

On the Mall in Washington, DC + September 17-21

Featuring: Queen ofthe torch ight, Betty James + Master of the 88
Francois de fa Patisse - Big Datdy Jortan and his Trumpeteers - Emilio
Caccitore ef i suo Jazz Htaliano + Saxophone Virtuoso Berhardt Sprecht +
As well as new Blue Planet artst Emlly Bright, Dido Estevan, and scores mare
of our planet’s bestjazz and blues superstars.




Opening a file
from within
an application

When you’re working in an application, you
don’t have to go to the Workspace Manager
to open a file. You can open it from within the
application itself.

1 Choose Open from the application’s

document menu.

The document menu may be titled

Document, File, Project, or something else.

It’s in the main menu just below Info.

A panel with a browser opens. Browsers are
lists of files and folders displayed in one or
more columns. At the top of each column
is the name of the folder that contains the
files and folders in that column. With
browsers you can navigate quickly through

a hierarchy of files and folders.

When you choose an
application’s Open
command, a panel with
a browser opens.

Click a folder (folders are
marked by an arrow{:) to
display its contents in the
next column.

Click the left or right arrow
to see folders above or
below the current view of
the file system.

2 Locate the file in the panel’s browser.
Click the file to sclect it.
The name appears in the Name field.
4 Click OK.

The panel disappears and the file opens in
its own window.

You can use the disk buttons in the panel to
work with floppy disks. (Working with disks is
described in the User’s Guide and in the on-line
help. See “For More Information.”)

2 February

aMarch

{iBerhard Sprecht.nﬁ”

Betty James.rifd

Big Daddy Jordan. -
Dido Estevanrifd Click a file to select it.
Emilio Cagccitore.ifi Or just double-click a
= file to open it directly.

Click to close the panel

Click to open your
home folder.

without opening a file.

Click to open the

selected file.
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Files

Creating a file

26

You create a file in an application to store 4 In the browser, click the folder where you

your work. want to save the file.

1 Choose New from the application’s 5 Type a name for the file in the panel’s
document menu. Name field.
A new, untitled window opens. 6 Click OK.

2 Do some work in the window, such as The name you entered appears in the
typing. window’s title bar.

3 Save the window’s contents in a file by If you close a new window without saving your
choosing Save from the document menu. work, no file is created and the work you’ve

done is lost.

The Save panel opens. It contains a

browser.

The Save command
opens a panel for saving
the contents of a window

in a file.

Click the folder you want
to put the new file in.

Bessie Smith
The Empress of the Blues, she was born in poverty
only to become one of the most renowned—and
highest paid—blues performers of her day.

Type a name for the file.

Click to save the file.




Saving changes

to a file

Tip: Save changes
frequently, not just
when you’re about to
close a file.

To save changes you've made to a file

» While working in a file, choose Save from
the application’s document menu.

The contents of the window are saved,
replacing the last saved version of the file.

Bessia Smith
‘The Empress of he Blucs, she was bom o poveryy
anly to become one of te mot renowned—and
highestpaid—blues pestormers ofher doy.

File on a disk before saving

To save a copy of a file under a different name

1 While working in the file, choose Save As
from the document menu.

The application’s Save panel opens.

2 Use the panel to give the new file a name

and put it in a folder (as described on the
previous page).

The original file is put away without
changes. The file with the new name is

saved with

any changes, and you can

continue working with that file in the

window.

© ArustBiosnf — ~

Bessie Smith
The Empress of the Blues, she was bom in poverty
only to become one of the most renowned—and
highest paid—blues performers of her day.

- Memphis Slim

Over the course of half a century, this Arkansas
pianisttook the Blues from the barrethouses and
dives of Beale street, to the the big-name blues world
of Chicago, and across the ocean to the world,

Reverend Gary Davis
Herose from playing hard-time gospel on the streets
of Harlem to becorming one of the ereat folk lesends |

T

1—7

I

Edited copy in window

P

L

You know a
window
contains
unsaved work if
its close button
is partially
drawn.

1N

Bossia Smith
‘The Empress of the Blues, she was bom n poverty
o0ty to become ane of the most renowned—and
bighest paid—blues performers ofher day.

‘Over the.course of hlf a century, this Arkansas
pianist took the Blues from the barreliouses wnd
dives of Beale street, o the the big-name biues world
of Chicago, and across the ocean o the warld

Reversna Gary Davis
He rese from playing hard-tme gospel on the sueets
et

File on a disk after saving

Artist Bios.ntf — ~

Bessie Smith ~

» The Empress of the Blues, she was bem in poverty
only to become one of the most renowned—and
highest paid—blues performers of her day.

Memphis Stim
QOver the course of half a century, this Arkansas
pianist took the Blues from the barrelhouses and
dives of Beale street, to the the big-name blues world
of Chicago, and across the ocean to the world.

i Reverend Gary Davis
|4 He rose from playing hard-time gospel on the streets
b4 lem to becoring one of les

Edited copy in window

After saving,
the close
button returns
to normal.
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Editing

Typing text

30

The cursor becomes an I-beam
when you can enter text.

Text you type appears at the
insertion point—which is marked
by the blinking vertical bar.

You can also press one of the arrow
keys on the keyboard to move the
insertion point.

In most applications, you type text the same
way whether you're editing a document or
entering a value in a field.

1 Click in the window where you want

to type.

For example, click in an Edit document
window.

'The window you click in becomes the key
window (if it isn’t already), and the insertion
point appears.

"Type your text.

You don’t need to press the Return key at
the end of each line. The insertion point

moves forward as you type each character.
Lines break automatically between words:

Owver the course of a half century, Mermnphis
Slim took the Blues to Chicago—and across
the ocean to the big-name Blues venues of
the world)

3 To end a paragraph and move the insertion

point to the next line, press the Return key.

To insert text, click where you want the
text.

The insertion point appears where you click:

Over the course of a half century, Memphis
Slim took the Blueq to Chicago—and across
the ocean to the big-name Blues venues of
the world.

"Type what you want to insert.

The text you type is inserted, and lines in
the paragraph are adjusted to make room for
the new text:

Ower the course of a half century, Memphis
Slim took the Blues from the barrelhouses
and dives of Beale Streeqto Chicago—and
across the ocean to the big-name Blues
venues of the world.

Over the course of a half cegun'y, IMernphis Slim took
the Blues from the barrelhouses and dives of Beale
Streefto Chicago—and across the ocean to the
big-name Blues venues of the world.




Deleting and
replacing

Tip: As a shortcut,
select a word (and the
space that follows it)
by double-clicking the
word. Select a
paragraph by triple-
clicking it.

To delete text

1

Or

Selected text is highlighted to e
make it stand out. fose

Press Backspace to delete
selected text. Or type new text
to replace what you selected.

Put the insertion point directly after the text
you want to delete.

Press the Backspace key to delete the
character to the left of the insertion point.
Keep pressing Backspace to delete as many
characters as you want.

Select the text you want to delete by
dragging across it.

"The selection is highlighted.

Press Backspace to delete the entire
selection.

To replace text

1
2

Select what you want to replace.
Type the new text.

As soon as you start typing, the selected text
is deleted and the text you type is inserted
in its place.

In some applications, you can also use these
editing techniques with graphics. For example,
if you select a graphic and press Backspace, the
graphic is deleted.

Cver the course of a half century, Iv%mplusShmItn ok
the Blues from the barrethouses and dives of Beale
Street to Chicago—and across the ocean to the
big-name Blues venues of the world.

Over the course of a half century, this Arkansas
pianisytook the Blues from the barrelhouses and
dives of Beale Street to Chicago—and across the
ocean to the big-name Blues venues of the world.

_Artist Biosrf — ~
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Editing

Moving and To move text To copy text
copying 1 Select the text you want to move. 1 Select the text you want to copy.
2 Choose Cut from the Edit menu. 2 Choose Copy from the Edit menu.
The selected text is deleted. 3 Put the insertion point where you want to

insert the text you copied. Or select text you

3 Put the insertion point where you want to
want to replace.

move the text you cut. Or select text you
want to replace with the text you cut. 4 Choose Paste from the Edit menu.

4 Choose Paste from the Edit menu. A copy of the text is inserted.

The text is inserted just as though you
typed it.

Select the text you want to move ~ N
and choose the Cut command. _hrustBiosntf —-~

Ower the course of a half century, this Arkansas
pianist took the Blues from the barrelhouses and
dives of Beale Street to Chicago—and across the
ocean to the big-name Blue

Then put the insertion point where
you want to move the text and
choose Paste.

i ﬁrtist. Biu§.rtf -

Cwer the course of a half century, this Arkansas

Tip: You can choose pianist took the Blues from the barrelhouses and

Paste repeatedly to dives of Beale Street to the big-name Blues venues
paste what you last cut of bhicagu—and across the ocean to the world,

or copied as many times

as you like. e e e
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Changing fonts

You can change the text fonr to emphasize key
phrases with bold or iza/ics—or to give the text
a different look altogether.

1 Select the text you want to change.
2 Choose the Font Panel command.

The Font Panel command may be in the
Format, Font, or other menu, depending
on the application.

The Font Panel opens.

3 Click in the Family column to select a
Jont family—a collection of characters with
a consistent design.

4 Click in the Typeface column to select a
typeface, such as bold, izalic, or bold italic.

Click in the Size column to select a font size.

Click the Set button to apply the new font
to your text selection.

You can also make selected text bold or italic
by choosing the Bold or Italic command in the
Font menu.

Times Bold 18.0 pt.
Select a font family in this column. . 1 Select a
1 : o & s - typeface in
[ Tamiy || Togemse [ S || fhscolumn.

Click to preview the selected font
at the top of the panel before

. Youcantypea

|Roman :
et font size here.

= Click a size in
this column.

applying it.

Click to undo your selections in

Click to apply
m— the new

the panel.

settings to

selected text.
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Organizing

Renaming files
and folders

36

You can rename an existing file or folder by
editing its name in the File Viewer.

1

Select the file or folder you want to rename.

The icon of the selected file or folder is
highlighted. You can edit the file name in
the icon path or in the current view.

3 Press Return.

The new name appears below the icon and
everywhere clse the file appears.

If you don’t have permission to rename a file
or folder (usually because it belongs to
someone ¢lse), a panel alerts you and the

unedited name is restored. (Permissions are
described in the User’s Guide and in the on-
line help. See “For More Information.”)

2 Click in the name to select an insertion
point or select all or part of the name you
want to replace.

Caution: Don’t rename an application, or the

Workspace Manager won’t be able to start it up

when you open a file associated with it.

You edit the name as you normally edit text.

When you click in the name of a file
in the icon path or the current view,
an insertion point appears.

Mailboxe




Creating a folder

You can create folders to organize your files.

1 Open the folder where you want to create a

new folder.

Make sure its icon is highlighted in the
icon path.

Choose the New Folder command from the
Workspace Manager File menu.

A folder named NewFolder appears in the
folder you opened. The name NewFolder
is selected for editing.

Fie Viewer _—_

NextApps

If you don’t have permisston to change

the contents of a folder (usually because it
belongs to someone else), the New Folder
command is dimmed in the menu.
(Permissions are described in the User’s
Guide and in the on-line help. See “For
More Information.”)

3 Type a new name for NewFolder and

press Return.

The new folder is empty at first, but you can
save new files in it, create other folders in it, and
move or copy existing files or folders into it.

NewFoldet

Follow This Upt.if

- bright fax fax

et

‘Reaction Repotis.

Choose New
Folder from
the File menu
to create an
empty folder
named
NewfFolder.

Type a new
name for the
folder and
press Return.
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Organizing

Moving files
and folders

Tip: You can also move
files and folders by
dragging them into or
out of the current view.

38

You can move files or folders into other folders

in the File Viewer—for example, to move
a file into a folder you’ve just created.

1 Select the file or folder you want to move
and drag it to the shelf.

2 Open the folder you want to put it in.

"The folder’s icon is highlighted in the
icon path.

. NextApps
il o rerote disk g

3

Blues ol

Hold down the Command key as you drag
the file or folder you want to move from the
shelf to the folder in the icon path. (On most
keyboards, the Command key is the key to
the left of the space bar.)

‘The cursor changes color and the folder
opens to confirm that the file or folder
will be moved into it. If you don’t have
permission to change the contents of a
folder, the cursor stays black and the
folder’s icon doesn’t open.

Release the mouse button.

What you dragged is removed from its
previous folder and placed in the folder you
dragged it to.

File Viewer

‘The cursor changes color and the
folder icon opens to confirm that
the file or folder you're dragging

will be moved there.




Copying files
and folders

Tip: You can also drag an
icon from the icon path
or current view into a
folder that’s on the shelf.

To copy a file or folder

1 Drag the file or folder you want to copy

onto the shelf.

Open the folder where you want to put
the copy.

"T'he folder is highlighted in the icon path.

Hold down the Alternate key as you drag
the file or folder you want to copy from the
shelf to the folder in the icon path. (On most
keyboards, the Alternate key is the key to
the right of the space bar.)

The folder icon opens and the cursor
changes to a [[] to confirm that you're
making a copy.

Release the mouse button.

A copy of the file or folder is created in the
folder you dragged it to.

NextApps

2 o pernte disk

To make a copy of a file or folder in the
same folder

1

Select the file or folder you want to copy
and choose Duplicate from the
Workspace Manager File menu.

A copy of the selection appears in the
same folder with its same name, preceded

by CopyOf.

Rename the copy, if you like.

‘Backup Files

You know you’re copying a file or
folder—rather than moving it—if
the cursor changes to a[[}.
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Organizing

To delete a file or folder

Deleting files
and folders

1 Select the file or folder you want to delete.

2 Drag its icon from the File Viewer to the

recycler icon.

3 When the recycler arrows start to rotate,

release the mouse button.

The file or folder is deleted. When you
recycle a folder, you delete everything in
it, including the contents of all the folders

it contains.

The files and folders you recycle aren’t gone

for good until you empty the recycler.

To retrieve a deleted file or folder
1 Double-click the recycler icon.

The recycler window opens. It contains

all the files and folders you’ve put in the
recycler since you last emptied it. You may
have to scroll to find the file or folder you
want to retrieve.

2 Drag the file or folder you want to retrieve
to a folder in the File Viewer.

The file or folder reappears in the File
Viewer.

Active.mbox

To getrid of a
file or folder, e

drag it to the Edit
recycler icon. Dk

Tools
‘Windovrs
 Services
Hide

+
r
P
s
View r
T
I
i
h

1o oste | Compose

18

Maboxss Pt

on

S

L

e

S Octan - Steve Jobs - -

Tip: You empty the

recycler and destroy its
contents for good by
choosing the Empty
Recycler command
from the Workspace
Manager’s File menu.
You should empty the
recycler periodically to
reclaim disk space.
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Mail, Printing, & Faxing

Opening your 1 Start up or unhide the Mail application. When Mail is running, you can tell at a glance
i . . . . whether you have new mail by the appearance
mail The Active mailbox window opens, with a you hav Y bP
list of the mail you've received. New mail of the Mail icon in the dock. You can also tell
. . how many pieces of mail you haven’t read yet.
you haven’t read is marked with a {3, yp y y
. . ~&= Number of unread
2 C(Click a message in the summary area. messages
The message is displayed in the lower
portion of the window. No new mail You have new mail!
Click to step Acu've.mhox
through
messages. ® 1
Delete:
Anne Winn .. s
Click the Pierre Poupon # Materials for festival progra
summary of the ~Anne Winn® " Big ConcertFriday! .

-Voiceovers for TV promo
Program materials -
_Sprecht interview on BBC -

message you Max Basi

want to read.

~-Uri Kohn'

Date: Wed, 3 Jun 94 09:05:02 GMT-0800
From: paupon (Pierre Poupon)

To: grey

Subject: Materials for festival program

The message’s Cc: laurier, mathieu, bourget, starr
text, p lctur_es, Bonjour, Kaya!
and other items

are shown here. I received the fax yesterday with the preliminary designs for the festival program and have
passed them around here. Everyone applauds. As for the photographs you requested, I'm
afraid it will be the end of the week before we can send them to you. M. Lautier in our legal

department has to clear them. | hope that won’t slow you down.

1l Here’s afile with some comments from our Paris office:

Double-click an
enclosed file to
open it.

4 Ilook forward much to seeing you again at this year’s festivall

Au revolr




Sending mail

Tip: If you're sending
mail to people who
don’t use NEXTSTEFR,
click the NeXT Mail
button (so it changes to
Plain Text or MIME Mail)
before you click Deliver.

If you have a message, a file, or even a folder
full of files you want to share with others, you
can send it in a Mail message.

1 Start up or unhide the Mail application.

2 (lick the Compose button in the Active
mailbox.

3 "Type the addresses of the people you want

to send the message to in the To field.

Separate multiple addresses with a comma

and a space.

For more information about addresses, see

the User’s Guide or the on-line help.

"Type a subject for the message in the
Subject field.

"Type addresses of people you want to send
a “carbon copy” of the message to in the
Cc field.

Type your message in the main part of
the window.

If you’re sending the message to people
who use NEXTSTEP, you can use different
fonts in your message. You can even drag in
a file or folder from the File Viewer.

When your message is complete, click
Deliver.

Active.mbox X

Compose

Click Compose Pt e T
RN
{}, Delete
Type addrgsses Compose
and a subjectat [ i
the top of the To:| BluePlanet_SF
window.

Subject[Big ConcertFriday!

l_,H_'Cc:isammi_wright@glohalvoice.com poupon

AR

When your . i
message is Lip Service Addresses Reply &1 | Forward MeXT Mail | No Receipt
complete, click -
Deliver. :

Hey Everybody!!!
f:;:;a);eug ere Don’t forget that this Friday night is the first-ever Bay Area
Youcandragfiles | |©| @appearance of recent Blue Planet “signee™ and scat sensation

and folders into
your message to
include them as
attachments.

Some graphics
files are
displayed as

graphics, instead

Dido Estevan

8:00 pm at the Sweetwater Pavilion

Come early for press hour and hors d’oeuvres
{don’t forget your badges).

program and have
- |sou requested, I'm
Laurierin our legal

of as file icons.




Mail, Printing, & Faxing

Preparing a file
for printing
or faxing

44

Before you print or fax a file, you can make a
few choices about how you want your pages
to appear.

1 Open the file you want to print or fax and
choose the Page Layout command.

The Page Layout command is often in an

application’s Format menu or main menu.

The Page Layout panel displays the current
page layout settings for the file. The paper

dimensions are shown in the Width and
Height fields.

2 Use the Paper Size or orientation buttons
if you want to change the paper size.

6

Use the Layout button to change the
number of pages that fit on a sheet of paper.

Use the Units button to change the unit of
measurement for Width and Height.

"Type a percentage in the Scale field to
change the size of your pages.

Click OK.

Some settings affect your pages on screen,
while others take effect only when you print
or fax.

You can use iUp k=

the Page 2Up T

Layout panel aUp

tochange how B Up

your pages - e

appear when HLLLESER

g’:tﬁggl or To use a button with al, press
the button and drag in the list of
options that appears to choose the
one you want.

Orientation Ppr'sraut

buttons L E




Printing a file

You can printa file on a printer that’s connected
to your computer or that’s available on the
network.

1 Open the file you want to print and choose
Print from the main menu.

The Print panel opens.

2 'Iype the number of copies you want in the
Copies field.

3 If you don’t want to print the whole file,
type the starting and ending page numbers
of the pages you want to print in the From
and To fields.

Use the Paper Feed button to feed paper
automatically from the paper cassette or to
feed individual sheets by hand.

Use the Resolution button to choose the
number of dots per inch (dpi).

If your printer has other options, use the
Options button to set them.

Click Print.

The Progress field displays the message
“Writing page x” as it prepares cach page
for the printer.

Print

Name:  Repertoire_tColor_Frinter

Maote: in the record library,
Progress:

“|Local_Printer

MNeXT 400 dpi Level Il Printer

If more than one printer is

Repertoire_Color_Pri NeXT Color Printer

available, click the printer you
want.

Sly_Personal_Printer NeXT 400 dpi Level ll Printer

Click to set special options for

Click to preview
your pages on

From|
- screen instead of

Cassette’

printing them.

the selected printer.

== Click to print

the file.
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Mail, Printing, & Faxing

Faxing a file If you have a fax modem, you can fax your 4 If you don’t want to fax the whole file, type
pages to anyone who has a fax machine or starting and ending page numbers in the
fax modem. From and To fields.

1 Open the file you want to fax and choose 5 Check Receipt to get a mail message when
Print from the main menu. the file has been faxed.
The Print panel opens. 6 Check Fine to increase the sharpness of the

2 Click the Fax button. pages you fax.

7 Click Edit to change the cover sheet you
send with the fax.

8 Click Fax Now.

The Fax panel opens.

3 Enter a name and fax phone number by
typing or by clicking address book entries in
the browser. The Progress field displays the message

“Writing page x” as it prepares each page for

the fax modem.

The address books that appear in the Fax
panel are the same as the ones in the
Workspace Manager. (See the User’s Guide
or Workspace Manager’s on-line help.)

Fax

Modefm: : My_Féx_Moa‘em -
Progress: - ...

Select people
Ty — you want to fax
pero, Carmen *. the file to.

=hz, Fl N Or type a name
Pilar Feliz = and fax phone
o SE— number directly
“““ in the Fax panel.

49,1 2“13)555 1212

Click to change the cover sheet
you send with the fax.

Click to open a panel Where you s

= Click to send the fax.
select a fax modem. -
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Information

Clicking for help When you’re working in the Workspace 2 Click the command, window, button, or
Manager, Mail, Edit, and in many other other object you want help with.
applications, you can get help with your
work by clicking an object on the screen.

1 Hold down the F1 key on the keyboard.

The Help panel opens, with information
about the object you clicked.

You can scroll in the Help panel to read
The cursor changes to a question mark Q. more, or click any word or phrase marked with

If your keyboard doesn’t have an F1 key, a<» button to get help on a related topic.

you can try getting the question mark cursor
by holding down the Alternate and Control
keys at the same time.

When you press
the F1 key, the
cursor changes
to a question
mark . Use it to

Mail Help Panel

click commands,

windows, or

buttons you want ed i

to find out about. nes R e
Services menu
Lists commands that request the services of other applications.
A service provides a shortcut to starting up an application and
requesting a specific action from it. For example, you can selecta
file’s pathname in a message and choose Open in Workspace
from the Services menu. The file opens without your having to
locate itfirstin the File Viewer.
The commands in the Services menu depend on which
applications you have

o Seealso
Click a 0 to -3 Use services
. @ Mail meny
get help with a
related topic.

Tip: If you want help
with help, use the
question mark cursor to
click the Help command
in the Info menu.




Getting help To get help with a specific task To get help with a specific topic

with a_tas"‘ 1 Choose Help from the Info menu. 1 Click the Index button in the Help panel.
or topic . .

The Help panel opens. An index of topics appears.

If the Help panel is already open, click in it 2 C(lick the topic you want help with.

to make it the key window. . . . '
Y Information about the topic you clicked

2 Click an entry in the table of contents. appears in the Help panel.

Instructions for the task you clicked appear
in the Help panel.

You can scroll the table of contents to find
the task you want help with.

Click to view an index

of topics. ——
[«»)
Click to view the previous e

topic you chose. et

vr PreT T
o Working with Text
—-J Selecttext
. . - Delete and replace
Click ataskinthe table of ) || Move and copy
contents to get help with o Format a message
h tta k _QJ Fmdlexhnamessage
tha SK. 1! Type special characters
oo Sata new fant JETTL iy
Drag this knob to resize =1 rg
each area. Format a message

» To setmargins, indentation, and tabs, choose Show Ruler from
the Text menu and adjustthe markers. » To realigntextina

s paragraph, choose Align Left, Center, or Align Right from the
Text menu.

Left margin marker Right margin marker i

o . o N\ : N |
Click a<}» to get help with 1| Fiestine o SN S S SR NS S ST S
a related topic. ndentation T T T e IR T T

Body indentation marker Tab marker

v Open the Text menu by choosing Textfrom the Format menu.

Vv You use anfer to alter margins, indentation, and tab stops.
The ruleris initially hidden, but you can make it appearina
Compose window with the Show Ruler command.

v Adjustmarkers by dragging them along the scale ofthe ruler.
TataNdl u,igxhn -




Information

Searching for
help

If you don’t see a task or topic you want help
with in the table of contents or index, you

can search for a word in all the help for an

application.

1 Open the Help panel.

2 (Click in the field at the top of the Help

panel and type the word you want to get

help with.

Type the word you want

Click Find.

The first topic that contains the word you
typed appears in the Help panel. The word
you typed is highlighted.

To find the next occurrence of the word,
click Find again.

The next place where the word occurs

appears in the panel.

help with here.

Then click the Find button.

The word you typed is

- ¥
|maibox 7

' Backtrack

e Using Help
-, Gethelphy topic
Click forhelp
‘The Basics

Open amessage i

- Shorcuts from the keyboard for opening messages
- Options for showing information about messages
Open afle or fulderm a message

receive are listed in the summary area of your
YWhen you select a message in the summary

v Messages
Active

highlighted.

50
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2 Set a‘sound 1o announce new messages

its appear in the message area below.

remtTTln

v Aemarks anunread message. A A marks a message that
contains formatting, sound, graphics, or aftachments. A M
marks a MIME message with formatting or attachments.

v You canhide Mail when youre done reading messages. As
long as Mail is running, its icon in the dock shows if you have
new messages.

v Ifyou dont see the sender’s picture, ask your system
administrator to set up Mail to show pictures.

v A message from a non-NEXTSTEP computer might have
uneven line endings. To even them out, resize the window so
it’s wider.

See also

& Open afie or folder in a message
& Listen to arecording in a message




Reading more
about
NEXTSTEP

In addition to this Quick Start and the on-line
help described in the previous pages, there are
a few other places to turn when you have

questions about NEXTSTEP.

» The User’s Guide explains all you need to
know to use NEXTSTEP—from the basics
touched on in this Quick Start through the
details of the user applications and utilities
bundled with the software. The User’s Guide
offers task-oriented, step-by-step
instructions as well as concepts and a
complete command reference.

» Power Tips is a quick reference to useful tips
and shortcuts in NEXTSTEP. It includes a
complete list of NEXTSTEP user and
system administration books, journals, and
on-line resources. It also tells how to contact
NeXT for more information and services.

» Release Notes describes the contents of the

current release of NEXTSTEP, plus alist of
known problems.

» [ustalling and Configuring NEXTSTEP

shows how to install NEXTSTEP on
your computer and how to reconfigure
NEXTSTEP when you reconfigure your
computer and its devices.

» Upgrading shows how to upgrade earlier

releases of NEXTSTEP to the most

current release.
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